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1. Introduction

Thank you for purchasing SmartST 2005 for Pocket PC. We hope you enjoy using your new GPS navigation software.

Whether you travel in your own country or elsewhere, SmartST will direct you to your destination without
the need for map books and second-hand instructions. The Global Positioning System (GPS) is available
free of charge, at any time, and is accurate to within 5 m (15 ft). Your SmartST map provides street-level
detail for door-to-door navigation, including Points Of Interest (POls) such as accommodation, railway
stations and airports.
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Use this manual to help you install SmartST, learn how to operate it effectively and safely, and discover
the range of features available to you.

Navman welcomes your feedback. To contact us or visit our website, see Support Information on page 64.

GPS and GPS Signals

The Global Positioning System ‘is a network of satellites that transmit accurate time and position
information worldwide. GPS receivers receive signals from these satellites and use the information to
determine an exact location.

Satellites orbit the earth at around 12,000 miles above the surface. While a GPS receiver can detect
signals from up to 12 satellites at any time, only three signals are needed to provide a position or
GPS “fix” (latitude and longitude) for vehicle navigation systems.

SmartST is designed to use GPS information to find your current position, and calculate the best
route to your desired destination using the available road maps. SmartST will then guide you with
voice and visual commands to your destination using the continuous stream of GPS data to track
your position.

The iCN GPS antenna receives GPS signals. To receive GPS signals, ensure that the iCN is
outdoors, or in a vehicle outdoors, and the GPS antenna has an unobstructed view of the sky. The
iCN can operate in all weather types except snowfall.

For details about reading the SmartST GPS Status screen, see page 19.

Safety Notice

WARNING: In a vehicle, it is your sole responsibility to place, secure and use the Pocket PC in a
manner that will not cause accidents, personal injury or property damage. The user of this product
is solely responsible for observing safe driving practices. It is your responsibility to read and follow
the vehicle mount installation instructions and to use the product consistent with your government’s
laws/regulations. Consult the vehicle manual to ensure the mounting location is safe.

It is your sole responsibility to adhere to the following safety instructions at all times:

* Do not operate the Pocket PC while driving or place the Pocket PC in a position that obstructs
the driver’s view.

* Do not mount the Pocket PC in a way that may be distracting or interfere with the safe operation
of the vehicle, the deployment of airbags or other safety equipment.

* Do not leave the Pocket PC in view while your vehicle is unattended, especially in strong or direct
sunlight.

* Do not use or handle the Pocket PC when it is hot; leave it to cool, out of direct sunlight.

Failure to adhere to these instructions may lead to serious personal injury, including death,

or property damage. Navman disclaims all liability for use of the iCN that contributes to

injuries, death, property damage or violates law.
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Upgrading from Previous Version
of SmartST

To upgrade your version of SmartST to version 2005, you must first uninstall previous versions of
SmartST Desktop from your computer and SmartST from your Pocket PC. Your maps, Favourites,
Quick Navs and settings will be retained unless you are upgrading from SmartST V1.90 (Product
Key: SSP-190-XXXXX-XXXXX) or 1.91 (Product Key: SSP-191-XXXXX-XXXXX).

Note: This upgrade procedure does not apply to PiIN 570.
Complete the following steps to uninstall previous versions of SmartST:

1. If you are upgrading SmartST on a Navman PiN Pocket PC 100 or 300, go to step 6.
If you are upgrading a different model of Pocket PC, continue to step 2.

2. If you have SmartST maps stored on a SD or MMC memory card, insert the memory card in your
Pocket PC or memory card reader.
3. Connect your Pocket PC to your computer using a USB cable, synchronisation cradle, or

other device that came with your Pocket PC.
* Microsoft® ActiveSync® will synchronise with your Pocket PC.

4. If you are upgrading from SmartST V1.90 and 1.91 continue to step 5.
Otherwise go to step 7.

. Versions 1.90 and 1.91 Only:
The maps supplied with SmartST V1.90 and 1.91 are not compatible with SmartST 2005.
Complete the following to uninstall maps from your Pocket PC and memory card.

()]

a. Open SmartST Desktop on your computer:
Start > Programs = Navman - SmartST Desktop.

b. Use SmartST Desktop to uninstall all maps from your Pocket PC and memory card.
c. Close SmartST Desktop.
d. Goto step 7.
6. PiN 100 and PiN 300 Only:
a. Insert the memory card that came with your PiN in to your PiN.
b. Reset the PiN by using the stylus to press the RESET button on the left side of the PiN.
. Open File Explorer on your PiN: Start = Programs -> File Explorer.
d. Browse to the memory card.
e. Tap and hold the 2577 folder. Select Delete from the Pop-up menu.
f. Tap and hold the Navman folder. Select Delete from the Pop-up menu.
g. Close File Explorer.

h. Reset the PiN by using the stylus to press the RESET button on the left side of the PiN.
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7. Uninstall SmartST from your Pocket PC using the Remove Programs feature in your Pocket
PC Windows® Settings panel:

Start > Settings > System tab - Remove Programs.
8. Uninstall Navman SmartST Desktop from your computer if it has previously been installed,

using the Add or Remove Programs feature in your Windows Control Panel:
Start > Control Panel = Add or Remove Programs.

Refer to subsequent chapters of this user manual to install and activate SmartST 2005, install new
maps and navigate to your destination.

paye)s buipen
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2. Pocket PC Features
4-Way Toggle

The style of the 4-way toggle differs between models of Pocket PC. It may be referred to as a
navigation button or navigation stick; it may be a 5-way toggle. See your Pocket PC manual to
identify the 4-way toggle.

Note: The Acer® n30 Pocket PC does not have a toggle. To use SmartST, you must first assign

Button 1 to <Scroll Right-> and Button 4 to <Scroll Left>.

See your Acer n30 manual for information on how to assign buttons.

Getting started

Toggle Description

Left <@ | Opens the Main Menu screen.

Cycles through the navigation screens once a route has been calculated:
) ® 2D Map screen

Right - ® 3D Map screen

® Next Instruction screen

e |nstruction List screen.

From the 2D Map screen, enables you to zoom in to view less of the street
3 map, but with more detail.
Up

From the 3D Map screen, with the Information button set to Angle,
enables you to increase the viewing angle.

From the 2D Map screen, enables you to zoom out to view more of the
street map, but with less detail.

Down ? From the 3D Map screen, with the Information button set to Angle,
enables you to decrease the viewing angle.

Touch-Screen

Use the stylus with the Pocket PC touch-screen to navigate and use the Main Menu options, set
destination addresses and configure the GPS status. See your Pocket PC manual for information
on using the stylus with the touch-screen.

Tap and hold the stylus on the 2D Map and 3D Map screens to activate the Pop-up menu.
See page 39 for information on the Pop-up menu.

Portrait vs. Landscape Screens

Microsoft Windows Mobile™ 2003 SE can display SmartST in portrait or landscape mode.

This manual shows most SmartST screens primarily in portrait mode; however, where landscape
mode significantly differs from portrait mode, both are shown.
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3. Installing SmartST

Begin by installing SmartST Desktop on your computer. Then install and register SmartST on your
Pocket PC, activate and download the maps you require from SmartST Desktop. You will need an
Internet connection to complete activation.

Note: Windows XP users, ensure XP Service Pack 1 or higher is installed before you install SmartST Desktop.
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Microsoft ActiveSync
Microsoft ActiveSync is used to establish a connection between your Pocket PC and your computer.
SmartST requires ActiveSync 3.7.1 or higher, which should have been included with your Pocket PC.

See your Pocket PC user manual for more information.

Step 1. Install SmartST Desktop on your
Computer

1. Close all open programs on your computer.
2. Insert the SmartST CD into your computer CD-ROM drive. The SmartST Desktop installer will start.

e |f your computer does not automatically launch the CD, start the installation manually:
Start > Run.
Type D:\Setup SmartST 2005 for Pocket PC.exe where “D” is the letter assigned to your
CD-ROM drive. Click OK.

3. Follow the screen prompts to install SmartST Desktop.
® Select your preferred language for SmartST Desktop when prompted.
® Review and accept the Licence Agreement for SmartST Desktop when prompted.
® Select a destination folder when prompted.

SmartST Desktop will open.

You are now ready to install and activate SmartST on your Pocket PC.
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Step 2. Install and Activate SmartST on
your Pocket PC

1. Close all open programs on your Pocket PC.
2. Connect your Pocket PC to your computer via Microsoft ActiveSync 3.7.1 or higher.
* Microsoft ActiveSync will synchronise with your Pocket PC.

3. Open SmartST Desktop if it is not already open:
Start > Programs - Navman - SmartST Desktop 2005 for Pocket PC.

4. Follow the prompts to install SmartST on your Pocket PC.

PiN 570 only: When prompted for the default installation directory, click No.
In the Save In box, select ROM Storage, then click OK.

Other Pocket PC models: SmartST must be installed in the default installation directory,
not a memory card.

5. If you connect to the Internet via a dial-up connection, connect to the Internet now.
6. Follow the prompts to register online and activate SmartST on your Pocket PC.
e Review and accept the Privacy Notice when prompted.

e You will be prompted to enter your contact details so Navman can advise you when
updates are released.

® Enter your SmartST Application Key from the back of the CD box when prompted.
® Your computer will connect to the Internet and activate your SmartST Application Key.

Your Pocket PC now contains SmartST 2005. You are now ready to install a map to your
Pocket PC or memory card.

Getting started
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4. SmartST Desktop

SmartST Desktop is used to manage maps to and from your Pocket PC, obtain software updates,
manage Custom Points of Interest (POls) and install Basemaps.

To Open SmartST Desktop

Once SmartST Desktop has been installed, you can access it from the Start menu:
Start > Programs = Navman = SmartST Desktop 2005 for Pocket PC
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Desktop and
Pocket PC tabs

Selected maps
Map Display
screen

Download
selected maps
to the Pocket
PC, memory
card or memory
card reader (not
supplied).

Map information

+— Map Colour Key

Uninstalling SmartST Desktop from your
Computer

We recommend that you use the Add or Remove Programs feature in your Windows Control Panel:
Start = Control Panel = Add or Remove Programs

Uninstall: € SmartST Desktop 2005 for Pocket PC.

1A
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5. Updating SmartST

Update your SmartST software to the most recent version by accessing the Navman website
through SmartST Desktop.

To update your SmartST software, complete the following steps:
1. If you connect to the Internet via a dial-up connection, connect to the Internet now.

2. Open SmartST Desktop:
Start > Programs = Navman - SmartST Desktop 2005 for Pocket PC

. On the Setup menu, select Update software then Check for updates on the web.
Your computer will connect to the Internet and display the Navman website.

Getting started

w

>

Download the update for your region to your computer, if available.

. On the Setup menu, select Update software then Update software on Pocket PC.
Follow the prompts to update SmartST.

o]
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0. Installing and Removing Maps
with SmartST Desktop

SmartST comes with one Map Product Key that will allow you to install one map. If you require an
additional map, you must first purchase an additional Map Product Key from your Navman supplier.

Use SmartST Desktop to activate your Map Product Key and install the required map.
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Installing New Maps

a. Insert a memory card into your Pocket PC, if you will be installing more than one map or if you will
be installing one map of a large region.

b. Connect your Pocket PC to your computer (if it is not already connected) using a USB cable,
synchronisation cradle or other device that came with your Pocket PC.

* Microsoft ActiveSync will synchronize with your Pocket PC.

c. Open SmartST Desktop, if it is not already open:
Start > Programs - Navman - SmartST Desktop 2005 for Pocket PC

d. Insert a SmartST Map CD into your computer CD-ROM drive, the available maps
will display (the default color for available maps is cross-hatch blue).

Note: If your computer opens Windows Explorer, close the Windows Explorer window.

Maps available on the Map CD in your CD-ROM
drive are displayed in cross-hatch blue.

e. ® Australia, New Zealand and North America users: If you have already activated a
Map Product Key for your country, go to step i; otherwise continue to step f.

e European users: If you have already activated a Gold/Pan-European Map Product
Key (activates all maps in Europe), go to step i; otherwise continue to step f.

f. Click the map you want to install to your iCN.

Note: You may need to install multiple maps to cover the desired geographical area.
g. If you connect to the Internet via a dial-up connection, connect to the Internet now.
h. Follow the prompts to activate your Map Product Key, including:

® Enter your Map Product Key from the back of the CD box when prompted.

 You will be prompted to enter or update your contact details so
Navman can advise you when updates are released.

® Your computer will connect to the Internet and activate your Map
Product Key.

e |f you are activating a map from a continental region that was not
previously installed on your Pocket PC, follow the prompts to
activate the new region. The four continental regions are Europe,
USA/Canada, Australia and New Zealand.

13
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* \When activation has completed, the map will change color (the default color for activated
maps is light green), proceed to step i.

The activated map is displayed in light green.

i. Click the map to install to your Pocket PC.
The map will change color to indicate it has been selected (the default color for selected maps is
dark green). The map is now listed in the Selected section of the Desktop Selected Maps tab.

j. * Australia, New Zealand and North America users: If you have already activated
a Map Product Key for your country, repeat step g until all required maps have been
added to the Selected section of the Desktop Selected Maps tab.

¢ European Gold/Pan-European Map Product Key users: If you have already
activated a Gold/Pan-European Map Product Key (activates all maps in Europe),
repeat step g until all required maps have been added to the Selected section of
the Desktop Selected Maps tab.

¢ European Silver/Single Map Product Key users: If you have another Silver/Single
Map Product Key to activate (activates a single map), go to step f.

The selected map is displayed in dark green.

k. Click an Add to button to install all maps listed in the Selected section of the Desktop Selected
Maps tab to your Pocket PC, memory card, or memory card reader (not supplied).
SmartST Desktop will install the selected map or maps to your Pocket PC or memory card.
When they have been installed, the map or maps will change color (the default color for installed
maps is yellow).

I. To use your iCN, disconnect the USB cable from your iCN.

WARNING: Do not disconnect the USB cable from the iCN USB Socket until the Map Display screen
has refreshed, and the installed map or maps have changed color (the default color for installed maps is
yellow).

14
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Removing Old Maps

Before you can install a SmartST 2005 map, you must first remove the old version of the map, as
you cannot use an old map and a SmartST 2005 map of the same area.

Complete the following for each map that you are upgrading:

a. Connect your Pocket PC to your computer (if it is not already connected) using a USB
cable, synchronisation cradle or other device that came with your Pocket PC.

* Microsoft ActiveSync will syncronise with your Pocket PC.

b. Open SmartST Desktop, if it is not already open:
Start > Programs = Navman - SmartST Desktop.
c. Open the Maps on Pocket PC section:
Pocket PC tab = Maps on Pocket PC.

d. Click the map to be removed and select Remove from Pocket PC from the pop-up menu.
The map will be removed from your Pocket PC.

15
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/. Starting SmartST

By now, you have installed SmartST on your Pocket PC and, if required, mounted your GPS receiver in
your vehicle. You are now ready to start SmartST and ensure that your Pocket PC and GPS receiver are
communicating successfully.
1. Refer to your GPS receiver manual about how to establish a valid GPS communications link
between your Pocket PC and GPS receiver.
2. Close all open programs on your Pocket PC to provide memory resources for SmartST.
Note: Tapping E or in the top right corner of an application does not usually close the
application, but leaves it running in the background. To close all applications, see your
Pocket PC manual.
3. Tap Start (a) to display the Start menu (see Figure 1).

4. Tap Programs (b) on the Start menu.

5. Tap ;.<.:.>.-,. (c) on the Programs screen (see Figure 2).
SmartST will open.

L

a Micrasoft MSN Notes
Reader  Messenger

g E W

7" Internet Explorer b Pictures  Packet Excel Pocket MSN
Tasks

i prageams W&

¥ Settings
g c — | Pocket SmartST  Terminal [=|
Es Find word Services

? Help ™~ S @ Client

Windows =
Media |

ER

Figure 1. Start Menu Figure 2. Programs Screen

PiN 570: The Language Selection screen will display on PiN 570s not purchased in Australia,
Canada, New Zealand, United Kingdom or United States.

* Tap the language name or associated flag icon, then tap @
6. The Legal Notice screen will display. Read the legal notice and tap | Agree to confirm you understand.

7. The Tutorial will display. Tap to move through the screens.
The 2D Map screen will open.
You are now ready to obtain a GPS fix. See GPS Setup on page 18.

PiN 570: You can also open SmartST by pressing the @ putton.
See the PIN 570 User Manual for detalls.

16
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Main Menu Screen

The Main Menu screen provides access to all SmartST functions, including navigating to a destination.
1. From the 2D Map screen, open the Main Menu screen by pushing the 4-way toggle *-9
2. Tap @ to display more Main Menu options.

iew w
{1
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8. GPS Setup

The Global Positioning System (GPS) comprises a collection of satellites orbiting Earth that transmit
signals to your Pocket PC. To navigate to a destination using SmartST, you must first obtain a GPS fix.

Getting a GPS Fix

To obtain a GPS fix, your Pocket PC must have a clear view of the sky.

1. From the Main Menu, tap @ then GPS Status.
The GPS Status screen will open:

GPS Status ok

[Japrs [caoms- -|
57600 ]

& 0
- GPS PORT CLOSED

2. Tap the first drop-down box and select the COM port for your GPS receiver from the list
that appears. See your Pocket PC manual for the correct COM port.

3. Tap the second drop-down box and select the baud rate (speed) for your GPS receiver
from the list that appears. See your GPS receiver manual for the correct baud rate.

4. Tap the GPS checkbox to open the COM port. Your Pocket PC will now obtain a GPS fix.
5. Tap e to return to the 2D Map screen.

Navman COM Ports and Baud Rates

This table gives COM Port numbers and Baud Rates for Navman GPS navigation products:

Device COM Port Baud Rate
Navman PiN 100 and PiN 300 COM 2 4800
Navman PiN 500 COM 8 9600
Navman Bluetooth GPS Receiver * 57600

“The COM port for the Bluetooth GPS receiver varies between models of Pocket PC.

18
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GPS Status Screen o
=2
The GPS Status screen provides a visual representation of the information being received. Latitude =]
and longitude are displayed, along with a north-pointing compass, ground speed and the heading (o]
in degrees. Available satellites are shown as segments. (7))
—
=1
Indicates whether the COM port is open —| Sobhin [ COM Port drop-down box, displays D
|@ters [come: [ selected GPS receiver or COM port o
Latitude and longitude of current position; o~ Baudrate drop-down box which
tap to toggle displayed units between 5 6°47.566" \ displays the selected baud rate for
degrees, minutes and decimal seconds; - . the GPS receiver COM port
decimal degrees; degrees and decimal E 174°45.843
minutes.

North-pointing compass and current
heading in degrees
Each segment represents a satellite

Ground speed

— GPS fix
Number of satellites used in GPS fix— |
| =% 5 UTCO02:56:21 | Coordinated Universal Time (UTC)
- 2004 12 20 and date

GPS Satellite Segment Key

Colour Description

Red No signal is being received.

A valid signal is being received but not being used to fix your position.

Green A valid signal is being used to fix your position.

19
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GPS Status Messages

The GPS status messages are displayed on the 2D Map, 3D Map, Next Instruction and GPS
Status screens. These messages provide feedback on the status of the GPS receiver connection.

The following table explains the meaning of these messages and includes suggested actions.

Status Message

Meaning

Suggested Action

GPS PORT CLOSED

A GPS COM port has not
been opened.

On the GPS Status screen, tap the GPS
checkbox to open the COM port selected
in the first drop-down box.

NO GPS DATA

A GPS COM Port has
been opened but no GPS
data are being received.

Ensure the GPS receiver is turned on
and connected.

WAITING FOR GPS

A GPS COM Port has
been opened, GPS data
are being received, but a
GPS position fix has not
yet been established.

Ensure the GPS receiver has an
unobscured view of the sky.

If you are in a vehicle with athermic (heat
reflecting) windows, you will require an
external GPS antenna (sold separately).

GPS LOST

Your GPS fix has been lost.

Ensure the GPS receiver has an
unobscured view of the sky.

(no GPS message;
date displayed on
GPS Status screen)

You have a valid GPS
position fix and GPS data
are being received.

No action required. You can navigate to
your destination.

20
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9. Setting your Destination

Before you travel, specify a destination and SmartST will plan your route. You may select a destination
using any of the Destination menu options.

Note: Depending on the destination country, some fields may be unavailable when selecting a destination.
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Entering Destination Text
Use the keyboard to enter text into the appropriate boxes on the Destination screens.

Note: If the text you enter does not match any address or Point of Interest (or any name in Pocket PC
Contacts), the text will turn red. In this case, check your spelling and try again.

Destination Icons

Each Destination screen displays a variable selection of icons:

Tap | To...

Return to the previous screen.

Display the Route Options screen.

Add current location to Favourites.

Show the current location on the 2D Map.

Calculate route and display the 3D Map.

Confirm selection.

Edit current Favourite.

Delete current Favourite.

View the Help screen for Destination icons.

Display information about the current item.

21
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Address Search Rules

The following rules apply when searching for a destination in Europe:
Street Names with Dates
If a street name contains a date or a number, search by the first number:
Example 1: If searching for “Faubourg du 13 Juillet 1920”, search by “13”.
Example 2: If searching for “Avenue du 14 Avril 1914”, search by “14”.
Example 3: If searching for “Rue de la 1 ere Armée”, search by “1”.

Streets Named After People (excluding Italy)

If a street name is a person’s name (including at least a first and last name), search by the first name:
Example 1: If searching for “Rue Albert Mathieu”, search by “Albert”.
Example 2: If searching for “Fred Archer Way”, search by “Fred”.
Example 3: If searching for “Franz Grillparzer-Strasse”, search by “Franz”.

Streets Named After People - Italy

In Italy, if a street name is a person’s name (including at least a first and last name), search by the last name:
Example 1: If searching for “Via de Angelo de Thomasis”, search by “Thomasis”.
Example 2: If searching for “Via Placido Giovanella”, search by “Giovanella”.
Example 3: If searching for “Via della Giacomo Marca”, search by “Marca”.

Postcodes in United Kingdom and Netherlands

When searching by postcode in United Kingdom or Netherlands, type the postcode with spaces and
without the last two letters.

Example 1: If searching for “RH6 9ST”, search by “RH6 9”.
Example 2: If searching for “3514 BN”, search by “3514”.

For exact European street type abbreviations, see Appendix: Street Types on page 61.

22
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Navigating to a Street Address

1. From the Main Menu, tap Destination, then Address.
The Destination Address screen will open.

Note: If you have previously selected a destination and not subsequently exited SmartST, the last
address will display.

Destination Address.

counte
Pastcada
Road

House No.
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2. Select a country from the Country drop-down box.

3. Type and select the destination address starting in any box, as follows:

Box Action

Postcode ¢ Tap the Postcode box.

The Destination Address - Postcode screen will display.

* Type up to five characters of the postcode in the Postcode box.
Note: When navigating in United Kingdom or Netherlands, type the
postcode with spaces and without the last two letters.

® Select the postcode from the list that displays.

® Tap e
The Destination Address screen will reopen.

Area ® Tap the Area box.
The Destination Address - Area screen will display.

* Type the name of a geographical location such as a town, city, state
or county in the Area box.

* Select the area from the list that displays.

e Tap e
The Destination Address screen will reopen.

Road © Tap the Road box.
The Destination Address - Road screen will display.
© Type the name of a road in the Road box.
® Select the road from the list that displays.
e Tap e
The Destination Address screen will reopen.

House number | e Tap the House No. box.
The Destination Address - House No. screen will display.
* Type the house number in the House No. box.
® Select the number from the list that displays.
e Tap e
The Destination Address screen will reopen.

23
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4. Complete one of the following:

® To calculate and display your route, tap @
The 3D Map screen will open.

 To display the address without calculating the route, tap @
The 2D Map screen will open.

¢ To add the address as a Favourite, tap @
The Favourite will be saved with the name of the road.

Navigating to the Intersection of Two Streets

1. From the Main Menu, tap Destination, then Intersection.
The Destination Intersection screen will open.

Note: If you have previously selected a destination and not subsequently exited SmartST, the last

address will display.
Destination Intarsaction o
Country  [UNITED KINGDGM ~]

Area  [LONDON, ENGLAND
Road 1 BUCKINGHAM ARCADE, LON
Road 2 BUCKINGHAM STREET, LOM

2. Select a country from the Country drop-down box.
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3. Type and select the destination address:

Box

Action

Area

® Tap the Area box.
The Destination Intersection - Area screen will display.

* Type the name of a geographical location such as a town, city, state
or county in the Area box.

e Select the area from the list that displays.

e Tap e
The Destination Address screen will reopen.

Road 1

¢ Tap the Road 1 box.
The Destination Intersection - Road 1 screen will display.
* Type the name of a road in the Road 1 box.
 Select the road from the list that displays.
* Tap e
The Destination Address screen will reopen.

Road 2

¢ Tap the Road 2 box.
The Destination Intersection - Road 2 screen will display.
* Type the name of a road in the Road 2 box.
A list of roads that intersect with the road specified in the Road 1 box
will display.
 Select a road from the list that displays.
® Tap e
The Destination Address screen will reopen.

4. Complete one of the following:

 To calculate and display the route to the intersection, tap @
The 3D Map screen will open.

 To display the address without calculating the route, tap @
The 2D Map screen will open.

 To add the intersection as a Favourite, tap @
The Favourite will be saved with the name of the road.
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©
il Navigating to a Point of Interest (POlI)
S A POl is a named site, feature, landmark or public venue which can be displayed as an icon on the
(7)) map. POls are stored in types, such as parks and museums.
(@)] Note: You can also navigate to a POl via the Pop-up menu. See page 39.
E 1. From the Main Menu, tap Destination, then Points of Interest.
-1: The Points of Interest screen will open.
8 Points of Interest e
Country
Category ALL hd
Type  |ALL TYPES -
- -

Select a country from the Country drop-down box.
Select a POI category from the Category drop-down box.
. Select a type of POI from the Type drop-down box.

SRR

. Select an Area by tapping the Area box.
The Destination Intersection - Area screen will display.

¢ Type the name of a geographical location such as a town, city, state
or county in the Area box.

e Select the area from the list that displays.

® Tap e

The Points of Interest screen will reopen.

6. Tap e

The Points of Interest screen will reopen.

7. Tap ‘
The Points of Interest Results screen will display, with a list of your search results. Only the first
40 search results will display.
. Select a POl from the list of search results.
o [f the list is long, begin typing the name of the POl in the Name box. The list of POls will
reduce to match your search.

[es)

9. Complete one of the following:

* To calculate and display the route to the POI, tap @
The 3D Map screen will open.

* To display the address without calculating the route, tap @
The 2D Map screen will open.

* To add the POl as a Favourite, tap @
The Favourite will be saved with the name of the POI.
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Navigating to a Favourite

To navigate to a Favourite, see Using Favourites, page 44.

Navigating to a Contact Address

Addresses stored in your Pocket PC Contacts database can be used to set a destination. The
contact address must be contained on an installed map.

pape)ls Bumen

1. From the Main Menu, tap Destination, then Contact.
The Find Contact screen will open.

Find Contact oK

() Business @ Home () Other

2. Type the name of your contact in the Name box. Select the contact name from the list that displays.
3. Tap the Business, Home or Other option to display your contact’s correct address details.

4. Tap @
The Destination Address screen will open.

5. Confirm that the correct details are displayed.

¢ |f the details of the contact address are incorrect they will display in red. Type and select
the correct details and tap @ Your Pocket PC Contacts database will be updated.

6. Complete one of the following:

© To calculate and display the route, tap @
The 3D Map screen will open.

* To display the address without calculating the route, tap @
The 2D Map screen will open.
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Navigating to a Recent Destination

The last 20 routes are stored as recent destinations.

1. From the Main Menu, tap Destination, then Recent.
The Recent Destinations screen will open.

Recent Destinations. oK
ASHLEY LANE, MOULTON
JACARANDA CLOSE, KINGSTON
HACKETTS LANE, WOKING

GROVE SHAW, BANSTEAD

2. Select a destination from the list.
3. Complete one of the following:

 To calculate and display the route, tap @
The 3D Map screen will open.

 To display the address without calculating the route, tap 6
The 2D Map screen will open.
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10. Using the 2D Map Screen to
Plan a Route

You can plan a route directly from the 2D Map screen using the Pop-up menu.
For more information on the Pop-up Menu, see page 39.

1. From the Main Menu, tap Map.
The 2D Map screen will display.

)
@

=
=2
«Q

0

—
Q

i
(9

Q

2. Scroll the map by dragging the stylus, then lifting it off the map. Repeat until your destination is visible.

® Zoom in or out of the map as required to locate your destination, using b to zoom in and 9
to zoom out.

3. Tap and hold the road or POl icon that represents your destination.
The Pop-up Menu will display.

Set as departure
Mavigate to
Quick Nav 3
Route Detour

Add To Trip

Add to favourites
Add Avoid Area
Clear Avoid Areas
Route Summary
Route Demonstrator

e 1 MNearest POL
SR s
[€{2581  Exit Application

4. Select Navigate to from the Pop-up menu.
SmartST will calculate and display the route to your destination.
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11. Trip Planner

Use the Trip Planner to set multiple destination points for your trip. SmartST will calculate a route via
each point, in the specified order.

Destination points can be added via the Trip Planner screen or by selecting Add To Trip from the Pop-up
menu. You can save up to 14 destination points per trip.

Trip Planner Icons

At the bottom of each Trip Planner screen, a variable selection of icons displays:

Return to the previous screen.

Reload the last trip.

Save the trip.

Load a saved trip.

Add a destination to the trip.

Calculate route and display the 3D Map.

View the Help screen for Trip Planner icons.

Creating a Trip

1. From the Main Menu, tap Trip Planner.
The Trip Planner screen will display.

Trip Planner ok
1. HEATH GARDENS, RICHMONL
2. JAMES'S COTTAGES, RICHMO
3. NIAGARA CLOSE, BROXBOURI
4. DARK LANE, BRI URNE

2. Tap . to add a destination point.
The Destination screen will open.
You may add a destination point using any of the Destination menu options.
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Adding a Destination Point via Address

1. Tap Address.
The Destination Address screen will open.

2. Select a country from the Country drop-down box.
3. Type and select the destination address:

Postcode ¢ Tap the Postcode box.
The Destination Address - Postcode screen will display.
* Type up to five characters of the postcode in the Postcode box.

Note: When navigating in United Kingdom or Netherlands, type the
postcode with spaces and without the last two letters.

e Select the postcode from the list that displays.

® Tap .
The Destination Address screen will reopen.

Area ¢ Tap the Area box.
The Destination Address - Area screen will display.

¢ Type the name of a geographical location such as a town, city, state
or county in the Area box.

e Select the area from the list that displays.

e Tap .
The Destination Address screen will reopen.

Road e Tap the Road box.
The Destination Address - Road screen will display.
¢ Type the name of a road in the Road box.
e Select the road from the list that displays.
e Tap .
The Destination Address screen will reopen.

House number | e Tap the House No. box.
The Destination Address - House No. screen will display.
® Type the house number in the House No. box.
e Select the number from the list that displays.
e Tap .
The Destination Address screen will reopen.

4. Tap '

The destination point is added to your trip.
* To add another destination point, go to step 2.
5. Tap Q to return to the Destination screen.
6. Tap @ to return to the Trip Planner screen.

7. Tap @

The 3D Map screen will open. SmartST will calculate and display the trip.
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Adding Destination Points via Other Options

You may add destination points to the Trip Planner using the Intersection, Points of Interest,
Favourites, Contact and Recent destinations options on the Destination menu.

Managing the Trip Planner

To manage destination points on the Trip Planner screen, tap and hold a destination point.
The pop-up Trip Planner Menu will display.

* To move a point up, select Move Up.

* To move a point down, select Move Down.

* To delete a point, select Delete.

* To delete all points, select Clear All.

* To skip all prior destination points, select Skip To.
To save the trip to your Pocket PC or memory card:

e Tap @

The Trip Save As screen will open.

® Type a name for the trip in the Name box.

® Select a folder in which to save the trip from the Folder drop-down box.

® Select a location from the Location box in which to save the folder and trip.

* Tap OK.
The Trip Planner screen will reopen.

Loading a Trip

1. From the Main Menu, tap Trip Planner.

The Trip Planner screen will open.
2. Tap @

The Trip Open screen will open.
3. Select the folder containing the trip to be loaded from the Folder drop-down box.
4. Tap the trip to be loaded from the list of trip (.trp) files.

The Trip Planner screen will reopen.

¢ |f you have a previous trip displayed on the Trip Planner screen, you will be prompted
with the option to append the loaded trip to the displayed trip.

5. Tap @

The 3D Map screen will open. SmartST will calculate and display the trip.
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12. Viewing your Route

Once a route has been calculated, there are several ways to view it. Cycle through the screens by
pressing the right 4-way toggle & button.

2D Map Screen

The 2D Map screen is always oriented north and shows your current position (if a GPS fix is
active) and surrounding street names. If a route has been calculated, the route and all turns are
highlighted.

To view the 2D Map screen, either tap Map on the Main Menu screen, or when a route has been
calculated, press the 4-way toggle @' to cycle through the screens.
* Navigate around the map by dragging the stylus across the screen.

 To display a smaller area in greater detalil, press b
e To display a larger area in less detall, press ?

e Tap and hold any point on the screen to access the Pop-up menu.
* Tap 0 to recentre the map on your current position.

S Your next turn is highlighted
& | in a different colour to
future turns. The colour wil
depend on the theme you
are using.

Your destination

L Your current position is
marked with (4-

1 _|Map recentre icon

Map scale \

Your current location DARTNELL PARK ROAD

33



SmartST 2005 for Pocket PC | User Manual

3D Map Screen

The 3D Map screen displays when a route is calculated, oriented to the travelling direction, with an

adjustable horizon.

To view the 3D Map screen when a route has been calculated, press the 4-way toggle & to
cycle through the screens.

 To display a smaller area in greater detalil, press b

e To display a larger area in less detall, press @

® Change the viewing angle using 3 to decrease the angle and @ to increase the angle
when the Information button is set to Angle.

e Tap and hold any point on the map to access the Pop-up menu.

Direction of next turn

Tap to hear next instruction.

Your current position is
marked with (..

Information Button
Tap to cycle through the
following display options:
® Speed
® Time
* Angle
¢ DTG (distance to go
to destination)

e ETA (expected time of

arrival at destination)
® TTG (time to go to
destination)

LEFT: DARTNELL AVENUE'

L Your next turn is highlighted
in a different colour to
future turns. The colour wil
depend on the theme you

| are using.

Distance to next turn
Tap to display the route
summary.

Speed &3 mph 350
Your current location

DARTNELL PARK ROAD
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Next Instruction Screen

The Next Instruction screen displays information that you need for the next turn, the direction of the
turn and the distance to the turn.

To view the Next Instruction screen, either press the 4-way toggle @* to cycle through the
screens until the Next Instruction screen is displayed, or tap Map on the Main Menu.

LEFT: DARTNELL AVENUE

Direction of next turn.
Tap to hear next instruction.

25 0 Distance to next turn

Information Buttons
Tap to cycle through the
following display options:
e Speed
* Time
e HDG (current direction
or heading)
¢ DTG (distance to go to
destination)
e ETA (expected time of
arrival at destination,
e TTG (time to go to ‘
destination)

Your current location

DARTNELL PARK ROAD

L Displays information from
AM Information Buttons
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Instruction List Screen

The Instruction List screen displays a list of the remaining turns to your destination, the direction
of the turn, the street name and the distance to the turn. Each distance shown in the righthand
column represents the distance from your current location to that turn. The next turn is highlighted.

To view the Instruction List screen, press the 4-way toggle @' to cycle through the screens until
the Instruction List screen is displayed.

® Scroll up and down the list of instructions using the scroll bar.

Direction of turn

Next instruction

§
§
g

Instruction List

RIGHT: A421/ST.
NEOT'S ROAD

SECOND EXIT:
A421/BEDFORD
SOUTHERN BYPASS

EXIT LEFT: A428{ST.

NEOT'S ROAD

SECOND EXIT:
AAZEfGDLDINGTON
RODAD

EXIT LEFT:
A428/GDLDINGTON
RODAD

SECOND EXIT:
A428/GOLDINGTON
RODAD

— Distance to turn

I~ Scroll bar
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Turn List View Screen

The Turn List View screen displays a map view of your next turn and a list of the remaining turns to
your destination. Each distance shown in the instruction list column represents the distance from
your current location to that turn. The next turn is highlighted.

 To view the Turn List View screen tap Turn List View on the Main Menu.

 Scroll up and down the list of instructions using the scroll bar.
® Tap an instruction to view the map for the turn in the map-view portion of the screen.

* There are minor differences between the portrait and landscape versions of the Turn List View
screen (see Figures 1 and 2), e.g., landscape does not contain the Direction of Turn panel.

Map view of your
next turn

Direction of turn

Turn List View

— Next instruction
LEFT: BI1119/MOUNT 30 (in yellow)
PLEASANT ft

RIGHT: KING'S
I AVENUE

ﬂ LEFT: KING'S AVENUE

|~ Distance to turn

Figure 1. Portrait

Map view of your
next turn

Distance to next —__|
tun

Turn List View
NTalTe LEFT: B1119/MOUNT
PLEASANT

J RIGHT: KING'S AVENUE Next instruction
(in yellow)
LEFT: KING'S AVENUE s
' ft Distance to turn

DESTINATION: KING'S 360
AVENUE ft

Figure 2. Landscape
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Viewing the Route Summary

A summary of the calculated route can be displayed on the 2D Map or 3D Map screen for five
seconds. The route summary includes:

® Departure street.
® Destination street.
 Distance of route.
® Time to go to destination (TTG).
 Distance to go to destination (DTG).
® Percentage of route completed (measured by distance).
To display the route summary:
1. Tap and hold the 2D Map or 3D Map screen.
2. Select Route Summary from the Pop-up menu. The route summary will display for five seconds.

Departure
PARK SIDE
Destination
ALBERT DRIVE

S5omi
mir
mi

You can also display the route summary from the 3D Map and Next Instruction screens by tapping
the lower-right corner of the screen.

Viewing the Location Summary

A summary of a location can be displayed on the 2D Map or 3D Map screen.
The location summary includes:
* Name of street, POI, Favourite or Quick Nav.
® Description of location.
e Latitude and Longitude of location.
To display the location summary:
1. Tap and hold the 2D Map or 3D Map screen.
2. Select the location name from the top of the Pop-up menu. The location summary will display.

Road : LAMBOURNE CRESCENT

Location : 31 LAMBOURNE CRESCENT
WOKING
Guzil
ENGLAND

Latitude : N 51°20'12.12"
Longitude : W 0°31'25.35"

Back-On-Track™ Automatic Rerouting

Your route is recalculated if you make a wrong turn. The E symbol will display on the 3D Map and
Next Instruction screens while the route recalculates.

Automatic rerouting is set on the Route Settings screen.
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13. Map Screen Pop-up Menu

The Pop-up menu is displayed from the 2D Map or 3D Map screen by tapping and holding a point on the screen.

Location

Set as departure
Navigate to
Quick Nav »
Route Detour 3
Add To Trip

Add to favaurites

Add Ayoid Area

Clear Avoid Areas
Route Summary
Route Demonstrator
Nearest POT

wit Application

Menu Option

Description

Location

Displays the name of the selected road, POI, Favourite or Quick Nav.
Select to display the location summary.

Set as departure

Sets the selected point as your departure point.

Navigate to

Sets the selected point as your destination point.
SmartST will calculate and display the route to your destination.

Quick Nav

Displays a list of your Quick Navs.

Route Detour

Reroutes your route to avoid the next 1, 2, 5 or 10 kilometres or miles.

Add To Trip

Adds the selected point to your trip as a destination point.

Add to Favourites

Adds the selected point to your Favourites.

Add Avoid Area

Adds an Avoid Area for you to size and locate.

Delete Avoid Area

Deletes the selected Avoid Area.

Clear Avoid Areas

Deletes all Avoid Areas.

Route Summary

Displays the route summary.

Route Demonstrator

Starts the Route Demonstrator, demonstrating navigation from your
current position or departure point to your destination.

Nearest POI

Opens the Points of Interest screen. Select the POI to navigate to.

Exit Application

Exits SmartST.
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14. Avoiding an Area

SmartST enables a route to be calculated that avoids a specified area on the map. Up to ten Avoid
Areas can be added per route. Avoid Areas are displayed as shaded areas.

Adding an Avoid Area

1. From the Main Menu, tap Map.
The 2D Map screen will open.

2. Tap and hold the area that you want to avoid.

3. Select Add Avoid Area from the Pop-up menu.
An Avoid Area is displayed.

171 STRAND / A301

4. Set the Avoid Area to the correct size and position.
* To position the Avoid Area, tap and drag it to the area you want to avoid.
 To size the Avoid Area, tap and drag the sizing boxes to the size required.
5. Tap the Avoid Area to enable it.

Deleting an Avoid Area

1. From the Main Menu, tap Map.
2. Tap and hold the Avoid Area that you want to delete.

3. Select Delete Avoid Area from the Pop-up menu.
The Avoid Area is deleted.

Deleting all Avoid Areas

1. From the Main Menu, tap Map.
2. Tap and hold the 2D Map screen outside of an Avoid Area.

3. Select Clear Avoid Areas from the Pop-up menu.
All Avoid Areas are deleted.
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15. Route Demonstrator

The Route Demonstrator allows you to:

® Preview a route.

* Plan and view a route without a GPS fix, such as when you are inside a building.

Step 1. Select Departure Point

If you have a GPS fix, you do not need to select a departure point unless the demonstrated route’s
departure point is not your current location.

1. Find your departure point by scrolling the map with the stylus.
2. Tap and hold the road or POl icon that represents your departure point.
3. From the Pop-up menu, select Set as departure .

Step 2. Select Destination Point

1. Find your destination point by scrolling the map with the stylus.
2. Tap and hold the road or POl icon that represents your destination.
3. From the Pop-up menu, select Navigate to.

Step 3. Activate Route Demonstrator

From the Pop-up menu, select Route Demonstrator.

e |f you have selected the Repeat Route Demonstrator check box on the Display Settings
screen, the Route Demonstrator will repeat until you disable it from the Pop-up menu.

To Disable Route Demonstrator

From the Pop-up menu, select Route Demonstrator.
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106. Trip Meter

Trip Meter - Current Route Screen

The Trip Meter - Current Route screen is used to view the distance travelled, average speed,
maximum speed, time taken and stationary time for your current trip.

® From the Main Menu, tap @ then Trip Meter.

Trip Meter - Current Route e
Distance [miles) 000000
Average Speed (milesfh) 000
Max Speed (miles/h) 000
Time {h:m}) 000:00
Stationary Time (h:m) 000:00

The Trip Meter - Totals screen is used to view the distance travelled, average speed, maximum
speed, time taken and stationary time for all of your trips to date, or since the trip meter was last reset.

* From the Trip Meter - Current Route screen, tap @
The Trip Meter - Totals screen will open.

* Tap @ again to redisplay the Trip Meter - Current Route screen.
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17. Favourites and Quick Navs

Favourites are used to access frequently used destinations without having to reenter information.
Favourites are accessed from the Favourite List screen.

You are able to save your three most frequently used Favourites as Quick Navs. Using a Quick Nav is
the quickest and easiest way to set your destination. Quick Navs are accessed from the Quick Nav
screen, or from the Pop-up menu on the 2D Map or 3D Map screens.

Saving a Favourite

. From the Main Menu, tap Destination, then Address.
The Destination Address screen will open.
Note: You can also add an Intersection or POl as a Favourite.

—

N

Select a country from the Country drop-down box.

w

. Type and select the destination address:

¢ To select an area, type the name of a geographical location such as a town, city, state or
county in the Area box. Select the area from the list that displays.

¢ To select a road, type the name of a road in the Road box. Select the road from the list
that displays.

© To select a house number, type the house number in the House No box. Select the
numebr from the list that displays.

4. Tap @

The Favourite is saved with the name of the road.

Converting a Favourite to a Quick Nav

1. From the Main Menu, tap Destination, then Favourites.
2. Select the Favourite to convert to a Quick Nav.

3. Tap @

The Favourite Edit screen will display.
4. In the Save as box, select a Quick Nav to save this Favourite to.

5. To change the icon for this Quick Nav, tap the icon next to Change Icon.and select a new icon
from the Favourite Change Icon screen.
The Favourite Ediit screen will reopen.

6. Tap @ to save the Quick Nav.
The Favourite List screen will display.

Editing a Favourite or Quick Nav

1. From the Main Menu, tap Destination, then Favourites.
2. Select the Favourite to edit.
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3. Tap @

The Favourite Edit screen will display.

& dgaze @

Favourite Edit

Name Home

House No
Street CALDECOTTE LAKE DRIVE
Save as Quick Mav 1 -

Change Icon

® @@

4. In the Name box, type a name for the Quick Nav or Favourite.
5. To change the icon displayed on the 2D Map and 3D Map screen:

a. Tap the Change Icon icon.
The Favourite Change Icon screen will display.

b. Tap the icon you want for the Quick Nav or Favourite.

6. Tap @ to save the Quick Nav or Favourite.
The Favourite List screen will open.

Using Quick Navs

1. From the Main Menu, tap Quick Nav.

2. Tap your previously saved Quick Nav destination.
The 3D Map screen will open.
SmartST will calculate and display the route to the Quick Nav.

Note: You can also access Quick Navs via the Pop-up menu.

Using Favourites

1. From the Main Menu, tap Destination, then Favourites.
2. Select a Favourite from the list.
3. Select one of the following options:
o @ - Displays the Routing Settings screen.
. @ - Opens the Favourite Ediit screen to edit the Favourite.
@) - Deletes the Favourite.
o @ - Displays the Favourite on the 2D Map screen.
o @ - Calculates the route to the Favourite and displays it on the 3D Map screen.
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18. Settings

You can modify the following settings to suit your preferences:

Display Settings

1. From the Main Menu, tap @ then Setup, then the Display tab.

The Display Settings screen will open.

Rauting O

Raute

Quickest
Freeway Usage

Shartest

Min Max
Route Options

Allow Dual Carriagevay U-Turn
Avoid Unsurfaced Roads

[ Avaid Ferries

[ Avoid Tell Reads

[[] Avaid Urhan Arsas e

Automnatic Rerouting

Display | Guidam:gl Rnuhng‘ PO | Map‘ 4

2. Modify the settings as required:

If you want to...

Then...

improve screen contrast in light or dark
conditions

select either Day or Night in the Map
Colours section.

change the colour scheme of all map
screens

select your preferred colour scheme from
the Map Colour Scheme drop-down box in
the Map Colours section.

display a topographical map on all map
screens

select the Display Topography check box
in the Map Detail section.

display No Entry icons on blocked roads
on all map screens

select the Display Blocked Road Icons
check box in the Map Detail section.

display grid lines on all map screens

select the Display Map Grid check box in
the Navigation Options section.

enable auto-zoom when navigating to
your destination

select the Enable Auto Zoom check

box in the Navigation Options section. If
selected, the 2D Map or 3D Map screen will
automatically zoom in or out depending on
your speed to allow optimal view of your route.

enable the route demonstrator to play
repeatedly

select the Repeat Route Demonstrator check
box in the Navigation Options section.

display Favourites icons on all map
screens

select the Show Favourites check box in
the Navigation Options section.

3. Tap a to accept these changes and open the 2D Map screen.
Note: After tapping e the last open map or map instruction screen will display. This
is usually the 2D Map screen, but other possiblilities are the 3D Map screen, the Next
Instruction screen, the Instruction List screen and the Turn List View screen.
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Guidance Settings

1. From the Main Menu, tap @ then Setup, then the Guidance tab.
The Guidance screen will open.

Guidance e

Voice Instructions.

oice Instructions
\oice Scheme

English - UK Female -

Distance Units
) kilometres @ riles

Route Recording

Start Recording Play

Displey | Guidancs [ Rauting | P01 Hap [T 4Tk

2. Modify the settings as required:

¢ To enable voice guidance during navigation, select the Voice Instructions check box in
the Voice Instructions section.

¢ To change the voice scheme used for voice guidance during navigation, select
your preferred voice scheme from the Voice Scheme drop-down box in the Voice
Instructions section.

¢ To change the units used to measure distance in SmartST, select either kilometres or
miles in the Distance Units section.

3. Tap e to accept these changes and open the 2D Map screen.

Route Recording

You can record specific routes and save them to your Pocket PC or memory card for future reference.
Note: Route recording should be undetaken only for diagnostic or support purposes, as instructed by a
Navman customer service representative.

To start recording a route
1. From the Main Menu, tap @ then Setup, then the Guidance tab.
The Guidance screen will open.

. In the Route Recording section, tap Start.
The Save As screen will open.

. In the Name box, type a name for the route.
. From the Folder drop-down box, select a folder in which to save the route recording.

From the Location drop-down box, select a location in which to save the folder and
route recording.

6. Tap e

The Guidance screen will reopen.

7. Tap e
The 2D Map screen will open.

8. Navigate to your destination.

N

SN
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To finish recording a route
1. From the Main Menu, tap Setup, then the Guidance tab.
The Guidance screen will open.
2. Tap Stop in the Route Recording section, to stop recording the route.

3. Tap e
The 2D Map screen will open.

To play a route recording
1. From the Main Menu, tap @ then Setup, then the Guidance tab.
The Guidance screen will open.

2. In the Route Recording section, tap Play.
The Open screen will open.

3. From the Folder drop-down box, select the folder containing the route to be played.

4. From the list of recorded routes, tap the route to be played.
The Guidance screen will reopen.

5. Tap e
The 2D Map screen will open, and the route recording will play.

To stop playing a route recording

1. From the Main Menu, tap @ then Setup, then the Guidance tab.
The Guidance Settings screen will open.
2. In the Route Recording section, tap Stop to stop playing the route

3. Tap e

The 2D Map screen will open.
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Route Settings

1. From the Main Menu, tap @ Setup, then the Routing tab.

The Routing screen will open.

Routing 0
Raute
Quickest Shartest
Freeway Usage
Min Max
Route Options

Avoid Unsurfaced Roads
[ Avoid Ferries
[ Awoid Toll Roads

[ Avoid Urban Areas O

Autonatic Rerouting

Displey \ e | Rauting \ oI \ Hapl D

2. Modify the settings as required:

If you want to...

Then...

change the Route Type

move the Route slider towards Quickest for
SmartST to give more weighting to the fastest
time when calculating a route.

move the Route slider towards Shortest for
SmartST to give more weighting to the shortest
distance when calculating a route.

change the Preference for Freeways

move the Freeway Usage slider towards Min to
use freeways less often when calculating a route.

move the Freeway Usage slider towards Max to
use freeways more often when calculating a route.

avoid unsurfaced roads

select the Avoid Unsurfaced Roads check
box.

avoid ferries

select the Avoid Ferries check box.

avoid toll roads

select the Avoid Toll Roads check box.

avoid urban areas

select the Avoid Urban Areas check box.

enable Back-on-Track™ automatic
rerouting

select the Automatic Rerouting check box.
Back-on-Track will update the calculated route if
you take a wrong turn.

restore default settings

tap @.

3. Tap é to accept these changes.
The 2D Map screen will open.
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Points of Interest (POI) Settings

Points Of Interest (POls) in a region are grouped into categories. This function allows you to select
the category of POI that you need. For example, you may be interested in entertainment venues
only and want to disable other POI categories, such as schools.

1. From the Main Menu, tap @ then Setup, then the PO/ tab.
The POI screen will open.
ror ok

POI Display
Shaow Icons on Map

POI Categories

Shopping A
Entertainment
Amenities
Food And Drink =
Buidings And Monuments
Accommedation
Transport

Automotive Facilities
Sports Facilties

| IRIRIRIEIRIRIRIR]R]

=2
<
o
g
B
&
=
S
2
E
4]
~

2. To enable POls to be displayed on the 2D Map screen, select the Show Icons on Map
check box in the POI Display section.

3. Select or clear the appropriate check boxes in the POI Categories section until only those
categories of POls that you would like to display on the 2D or 3D Map screen are selected.

4. Tap e to accept these changes.
The 2D Map screen will open.

Active Map Selection Settings

The Active Map Selection Settings screen allows you to specify which of the available maps are to
be used. SmartST uses program memory to store map regions, so we recommend that you only
specify the map(s) that you currently require.

1. From the Main Menu, tap @ then Setup, then the Map tab.
The Map - Active Map Selection screen will open.

mMap @

Active Map Selection

Location

[iPAg File Store ~
V3.5) Sauthern England

VE.5) East Midlands

[43.5) Wales and West Midlands

Display \ e | Gl \ PO \ Hapl 4

2. Select a memory location from the Location drop-down box to display a list of the maps
installed in each location.
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3. Select or clear the appropriate check boxes until only those maps that you would like to use
are selected.

4. If you have access to more than one memory location, go to step 2 and select another location.

5. Tap e to accept these changes.
The 2D Map screen will open.

General Settings

The General screen allows you to export your Favourites to a comma-delimited (.csv) file. Comma-
delimited files can be accessed by most database systems.

To export your SmartST Favourites to a comma-delimited file, complete the following:

1. From the Main Menu, tap @ then Setup, then the General tab.
The General screen will open.

2. Select the Favourites option.

3. Tap Export to export your Favourites to: My Device/My Documents/Navman/Favourites.csv.
The message “Export Complete” will display.

4. Tap e
The 2D Map screen will open.

The General screen also allows you to delete all Favourites, Quick Navs or recent destinations.

To delete your SmartST Favourites, Quick Navs or recent destinations, complete the following:
1. From the Main Menu, tap @ then Setup, then the General tab. The General screen will open.
2. Select either the Favourites, Quicknavs or Recents option.
3. Tap Clear to delete your Favourites, Quick Navs or recent destinations.

4. Tap e
The 2D Map screen will open.

The General screen also allows you to choose to display the tutorial on startup. To display the
tutorial when starting SmartST, select the Show at Startup check box in the Tutorial section.

Sound Settings

1. From the Main Menu, tap @, then Setup, then the Sound tab.
The Sound Settings screen will open.

Sound 0

Volume

58% Test

Alerts
Speed Warning [0 [2] mph
Reroute Chime

Gererel [ Saund [ Active FOIs [ dbout] 4]0
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N

. Modify the settings as required:

* Move the Volume slider to the right to increase volume; move the Volume slider to the left
to decrease volume. Tap Test to test the volume.

* To enable an audible warning when travelling over a specified speed, select the Speed
Warning check box. Select the speed over which the warning is to sound.

® To enable an audible chime when Back-on-Track™ Automatic Rerouting is activated,
select the Reroute Chime check box.

. Tap e to accept these changes.

The 2D Map screen will open.

Active Points of Interest (POI) Settings

Active POls are custom POls that are announced when in close proximity. Custom POls are added
from the SmartST Desktop POI Editor.

1.

NS

From the Main Menu, tap @ then Setup, then the Active PO tab.
The Active POI Settings screen will open.

Select the custom POI to be configured from the POI drop-down box.
Select the Active check box to activate the POI.

. Modify the settings for the selected POI as required:

 To enable a visual warning when the POl is nearby, select the Visual Warning check box.
 To enable an audible chime when the POl is nearby, select the Sound Warning check box.

e Select the distance from the POI at which the visual warning displays or the audible chime
sounds, from the Distance box.

e Select the time from the POI at which the visual warning displays or the audible chime
aounds, from the Time box.

Tap e to accept these changes.
The 2D Map screen will open.
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19. SmartST Desktop Advanced
Features

Find a City or Town

To search for a city or town to verify the map region to be installed:

1. From the Map menu, click Find City.
The Find City window will open.

Eccles, England, United Kingdom

Eching, Bayern, Germany

Echt, Limburg, Metherlands

Echternach, Echternach, Luxembourg
Eckental, Bayern, Germany

Eckernfisrds, Schleswig-Holstsin, Germary
Ecublens, waud, Switzerland

2. Type the name of the City or Town in the City Name box.
The list of available cities will reduce to match your search.
3. Double-click the name of the city or town.

The Map Display will rotate to centre on the selected city or town and
or town location.

will mark the city

52



SmartST 2005 for Pocket PC | User Manual

Map Colours and Textures

To access the Desktop Colours section: Desktop tab = Settings - Colours.

Adjust the settings to change the look of the map type.

Colour Settings Description
l3p on Packet PC——————
’—MD ﬁ T Controls map colours.
Displays the:

!' * map border colour
® map colour

® map border width.

Lelr

Adjusts the map border width.

Controls the map display:
D:I:‘  solid colour,

* no colour,
e crosshatch texture.

Controls geographic features displayed on the map. Features are

¥ show Globe Texture - R
only visible if the map has no colour or crosshatch texture.

Map Layers

To conserve space on your Pocket PC and memory card, you can choose map layers to install.
The layers you can choose from are:
e Points of Interest (POIs)
® \Water, parks
e Land contours.
To access the Map Layers section: Desktop tab - Settings - Layers.
Select or clear each checkbox to indicate the layers to be installed with each map.

Please select the Map Data Layers that
vou weant to download to the Pocket
PG

elect Data to lpad—————
v POIs

[V Water, Parks ete,
¥ Land Coritours
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Points of Interest (POI) Editor

You can create custom Points of Interest (POls) using the POI Editor in two ways:

by creating your own POl files, or
® by using compatible POI files downloaded from the Internet.

A maximum of 25 Custom POl files can be saved on your Pocket PC. The Custom POl files are
listed on the My POI screen.

Custom POls can be set to enable a warning chime or visual warning when in close proximity at the
Select Active PO screen.

Creating a Custom POl File

1. Create a new POl File using the POI Editor.

e On the SmartST Desktop Map menu, click Points of Interest.
The POI Editor window will open.

® On the POI Editor window File menu, click New Text File.
The POI File Name window will open.

¢ Type a name for the file in the File Name box, then click OK. The file name can be up
to eight characters with no spaces.
2. Add a POl to the POI File.

e On the PO Editor window Edit menu, click New.
The POI Details window will open.

Cescrton |
Dwgraes, Meanns, Smconds | aceal Cagrest |

o FH 8 FEEE  [Ewcs
wws fH P 3 BRI |eecw

| Eois|

¢ Type a description for the POl in the Description box.

* On the Degrees, Minutes, Seconds tab, type or select the degree, minute and
second of the POl latitude in the Latitude boxes.

¢ On the Degrees, Minutes, Seconds tab, type or select the degree, minute and
second of the POI longitude in the Longitude boxes.

e To save the PO, click OK.
3. Repeat step 2 until all POIs have been added to the POl file.

4. On the File menu, click Save.
The POl file is saved.

5. Complete Saving a Custom PO File to your Pocket PC below.

Importing a Custom POI File

1. Download a POl file from the Internet and save it on your computer.
2. Open the PO file using the POI Editor

® On the SmartST Desktop Map menu, click Points of Interest.
The POI Editor window will open.
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e On the POI Ediitor window File menu, click Open Text File.

The Open dialogue box will open.

e Select the POl file from your local or network drive, then click Open.

3. Complete Saving a Custom PO File to your Pocket PC below.

Saving a Custom POl File to your Pocket PC

1. On the SmartST Desktop Map menu, click Points of Interest. The POI Editor window

will open.

2. On the POI Ediitor window File menu, click Save to Device. The PO/ Options window
will open.

w

. Modify the POI settings as required:

If you want to...

Then...

activate the POI

select the Active check box.

Note: If you do not activate the POI, you will be
able to configure only the POI Visibility Level
and Icon File settings.

enable a visual warning when the
POl is in close proximity

select the Visual Alert check box.

enable a warning chime when the
POl is in close proximity

select the Audio Alert check box.

change the units used to measure
distance for this POl

select the Metric or Imperial option.

select the distance from the POI
at which the visual warning should
display or the warning chime
should sound

select the distance from the Distance box.

indicate this POls priority when one
or more additional POls are in the
same locale

move the POI Visibility Level slider left or right.

select a custom POI type icon to
display on the map

Type the path to the icon file to be used to
represent the POI type, in the Icon File box, or
select the icon file from your local or network
drive clicking L1, locating the file and clicking
Open. The file must be a bitmap (bmp)
graphic with a minimum of 6x6 pixels and a
maximum of 32x32 pixels.
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4. Click OK and follow the prompts.
The POl file is saved to the Pocket PC as a Custom POI type.

o [f you want to change the file name, edit the file name in the PO File Name window
File Name box, then click OK.
The file name can be up to eight characters and cannot contain spaces.

Deleting a Custom POI File from your Pocket PC
1. On the Map menu, click Points of Interest.
The POI Editor window will open.

2. On the File menu, click Manage POI Files.
The Manage POI Files window will open, displaying a list of custom POl files installed on
your Pocket PC.

3. Click the File Name or Size of the POl file to delete.

4. Click Delete.
The file is removed from the list, but is not yet deleted.

5. To select another file to delete, go back to step 2; otherwise, proceed to step 6.

6. Click OK and accept the changes.
The selected file or files are deleted.

56



SmartST 2005 for Pocket PC | User Manual

20. Continuous Continental
Navigation

Basemaps allow you to seamlessly navigate between installed maps without installing maps of all
regions along your route. Each Basemap covers a large area, such as Western Europe or continental
United States and contains main roads that connect cities and towns. On the Basemap, you can select
aroad or POl as your departure point or destination.

All Basemaps:
e contain roads and ferry connections of high national and international importance.
e use less memory than would be necessary to install all equivalent detailed maps.
® exclude smaller roads and have a reduced level of geographical detail.
You can add and remove Basemaps using the Basemap Installer (see below).

Install Basemap
1. Open SmartST Desktop if it is not already open:
Start > Programs > Navman - SmartST Desktop 2005 for Pocket PC

2. On the Map menu, click Basemaps.
The Navman Basemap Installer window will open.

nan Basemap Installer

B2 AME Avalabln

{¥3) Ewrope Basemap
(3] Work! Oulre
I Meemmarsadis Mestha
¥ Mot furlable

== =

3. Click the appropriate Add button to install the Basemap to the Pocket PC, memory card
or memory card reader.

Activate Basemap on Pocket PC

1. From the Main Menu, tap Setup, then the Map tab.
The Active Map Selection Settings screen will open.

2. Select a memory location from the Location drop-down box to display a list of the maps
installed in each location.

3. Select the check box of the Basemap you require.
4. Tap a to accept the change and open the 2D Map screen.
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Remove Basemap

1. Connect the Pocket PC to your computer.
e Connect your Pocket PC to your computer via Microsoft ActiveSync 3.5 or higher.
e Close all open programs on your Pocket PC.

2. Open SmartST Desktop if it is not already open:
Start > Programs - Navman - SmartST Desktop 2005 forPocket PC

3. On the Map menu, click Basemaps.
The Basemap Installer window will open.

4. Select the Basemap to remove and click Remove.
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21. Improving Performance

SmartST requires an amount of allocated program memory equal to about 10% of the size of the
installed and active maps. Without enough allocated memory, you may receive an Out of Memory error.

Reducing Number of Active Maps

SmartST uses program memory to store maps, so we recommend that you only specify the map
or maps that you currently require. The Active Map Selection Settings screen allows you to specify
which of the available maps are to be used.

See page 49 for more information.

Increasing Allocation of Program Memory

SmartST requires an amount of allocated program memory equal to about 10% of the size of the
installed and active maps.

1. Tap Start to display the Start menu.
2. Tap Settings on the Start menu.
3. On the Settings screen, tap the System tab.

4. Tap the Memory icon.
The Memory screen will open.

5. Move the slider to the left until you have enough program memory listed on the right.
See your Pocket PC manual for more information.
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22. Accessories

These Pocket PC accessories are available for separate purchase from your local Navman retailer:

In-Vehicle Power Adaptor

12 V in-vehicle power adaptor with 2 m power cable

Universal PDA Mounting Kit

Mounts any PDA device in your car.
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Appendix: Street Types

Note: Belgium and Switzerland each list street types and their abbreviations in three languages.

Country Street Type Abbreviation
Austria BOULEVARD BVD
CHAUSSEE CH
PLATZ PL
STRASSE STR
Belgium (Dutch) BAAN BN
BERG BG
DREEF DR
LAAN LN
MARKT MKT
PARK PK
PLEIN PL
SQUARE SQ
STEENWEG STWG
STRAAT STR
Belgium (French) AVENUE AVE
BOULEVARD BVD
CHAUSSEE CH
IMPASSE IMP
MONT MT
MONTAGNE MT
PLACE PL
ROUTE RTE
ROUTE NATIONAL RN
RUE R.
SQUARE SQ
Belgium (German) CHAUSSEE CH
PLATZ PL
STRASSE STR
Finland GATAN GT
GATE GT
GATA GT
VAGEN V.
VAG V.
France ALLEE ALL
AVENUE AVE
BOULEVARD BVD
CHAUSSEE CH
DOMAINE DOM
FAUBOURG FG
IMPASSE IMP
MONT MT
MONTAGNE MT
PASSAGE PAS
PLACE PL
QUARTIER QU
ROND-POINT RPT
ROUTE RTE
ROUTE NATIONALE RN
RUE R.
SQUARE SQ
TRAVERSE TRA
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Country Street Type Abbreviation
Germany BOULEVARD BVD
CHAUSSEE CH
PLATZ PL
STRASSE STR
Ireland AVENUE AVE
BOULEVARD BVD
CENTRE CTR
CRESCENT CR
PLACE PL
ROAD RD
ROUTE RTE
SQUARE SQ
STREET ST
YARD YD
Italy CONTRADA C.DA
CORSO C.S0
FRAZIONE FR
LARGO LGO
PIAZZA PZA
PIAZZALE PLE
STRADA STATALE )
SUPERSTRADA SS
VIA V.
VIALE VL
Luxembourg ALLEE ALL
AVENUE AVE
BOULEVARD BVD
CHAUSSEE CH
DOMAINE DOM
FAUBOURG FG
IMPASSE IMP
MONT MT
MONTAGNE MT
PASSAGE PAS
PLACE PL
QUARTIER Qu
ROND-POINT RPT
ROUTE RTE
ROUTE NATIONALE RN
RUE R.
SQUARE sQ
TRAVERSE TRA
Netherlands BOULEVARD BVD
DIJK DK
DWARSSTRAAT DWSTR
DWARSWEG DWWG
GRACHT GR
KADE KD
KANAAL KAN
LAAN LN
LEANE LN
LOANE LN
PARK PK
PLANTSOEN PLNTS
PLEIN PLN
SINGEL SNGL
STRAAT STR
STRJITTE STR
STRAATWEG STRWG
WEG WG
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Country Street Type Abbreviation
Norway GATA GT
GATE GT
PLASSEN PL
VEGEN V.
VEI V.
Portugal AVENIDA AVE
BAIRRO BA
CALCADA CC
CAMINHO CAM
ESTRADA EST
LARGO LGO
LARGUINHO LARG
PRACA PR
QUARTO QT
QUARTA QT
QUINTA QU
RUA R.
SAO S.
SANTA S.
SANTO S.
Spain AVENIDA AVE
CALLE | C/
CALLEJON CJ
CAMINO CM
CARRETERA CR
GLORIETA G
PASEO PO
PLAZA P.
RAMBLA RBLA
RONDA RD
Switzerland (German) BOULEVARD BVD
CHAUSSEE CH
PLATZ PL
STRASSE STR
Switzerland (French) AVENUE | AVE
CHAUSSEE CH
IMPASSE IMP
MONT MT
MONTAGNE MT
PLACE PL
QUARTIER QU
ROUTE RTE
ROUTE NATIONAL RN
RUE R.
SQUARE SQ
Switzerland (ltalian) CONTRADA C.DA
CORSO C.sO
FRAZIONE FR
LARGO LGO
PIAZZA PZA
PIAZZALE PLE
VIA V.
VIALE VL
United Kingdom AVENUE AVE
BOULEVARD BVD
CENTRE CTR
CRESCENT CR

63




SmartST 2005 for Pocket PC | User Manual

Support Information

Support for

Australia:

Navman Australia Pty. Ltd

PO Box 479

Gladesville

NSW 2111

Australia
pcnsupport.aus@navman.com
WWW.navman.com

Support for

New Zealand:

Navman NZ Ltd
PO Box. 68-155
Newton
Auckland

New Zealand

pcnsupport.nz@navman.com
Www.navman.com

Support for
Europe:

Navman Europe Limited

4G Gatwick House

Peeks Brook Lane

Horley, Surrey RH6 9ST
United Kingdom
support@navman-europe.com
WWw.navman-europe.com

Support for the
US and Canada:

Navman USA Limited
27142 Burbank

Foothill Ranch, CA 92610
United States of America

Phone: 866-9-NAVMAN
support@navmanusa.com
WWW.havmanusa.com

NAVMAN DISCLAIM ALL LIABILITY FOR ANY USE OF THIS PRODUCT IN A WAY THAT MAY
CAUSE ACCIDENTS, DAMAGE OR VIOLATE THE LAW.

Compliance

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) This device may not cause harmful interference, and (2) this device must accept any interference
received, including interference that may cause undesired operation.

© 2005 Navman NZ Limited. Navman is a registered trademark of Navman NZ Limited. All rights reserved.
Microsoft Windows 98 SE, ME, 2000 or XP, Microsoft Internet Explorer are registered trademarks of
Microsoft Corporation. All rights reserved.

SmartST, Drive-Away and Back-On-Track are trademarks of Navman NZ Limited. All rights reserved.

Acer is a registered trademark of Acer Inc. All right reserved.

Adobe Reader is a registered trademark of Adobe Systems Incorporated. All rights reserved.

All other trademarks and registrations are the property of their respective owners.

Published in New Zealand.

MNOO0416A
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